7.  System Monitoring

7.1
Checking the Health and Status of the Network

Once a network has been discovered by HP OpenView IP discovery and layout, monitoring the state of the network can begin.  Monitoring includes tasks, such as, checking the map for color alerts which indicate problems, creating submaps needing special monitoring, and checking for network changes. 

Objects that have an abnormal condition can be identified without having to look at every object on the network map.  A color alert on a symbol indicates that some part of that object may have problems.  To isolate a fault somewhere on the network, follow the color alerts to increasingly more specific submaps until the specific object that is not functioning is reached.  Follow color alerts by opening child submaps of objects that contain a color alert.

In addition, HP OpenView has the capability of monitoring the status of each of the application servers and modes.  Through the use of this tool the user is capable of determining status of both hardware and software components.  

Each procedure outlined will have an  Activity Checklist table that will provide an overview of the task to be completed.  The outline of the Activity Checklist is as follows: 

Column one
- Order shows the order in which tasks should be accomplished.  

Column two
- Role lists the Role/Manager/Operator responsible for performing the task.

Column three
- Task provides a brief explanation of the task.  

Column four
- Section provides the Procedure (P) section number or Instruction (I) section number where details for performing the task can be found.  

Column five
- Complete? is used as a checklist to keep track of which task steps have been completed.  

Table 7.1-1.  Monitoring - Activity Checklist (1 of 2)

Order
Role
Task
Section
Complete?

1
Fault Manager
Starting NNM (Network Node Manger) and the Graphical Interface
(P)  7.1.1


2
Fault Manager
Verify that an object is not functioning
(P)  7.1.2


3
Fault Manager 
Looking at Maps for Color Alerts
(P)  7.1.3


4
Fault Manager
Looking at Maps for New Nodes
(P)  7.1.4


5
Fault Manager
Create Special Submaps for Monitoring Status
(P)  7.1.5


6
Fault Manager
Checking for Event Notifications
(P)  7.1.6


7
Fault Manager
Rediscovering Network
(P)  7.1.7


Table 7.1-1.  Monitoring - Activity Checklist (2 of 2)

Order
Role
Task
Section
Complete?

8
Fault Manager
Configure HPOV Monitoring Settings
(P) 7.1.1.1


9
Fault Manager
Setup Data Collection 
(P) 7.1.1.2


10
Fault Manager
Add Vendor MIBs 
(P) 7.1.1.3


11
Fault Manager
Community Name Setup 
(P) 7.1.1.3.1


12
Fault Manager
Setup Map  
(P) 7.1.1.4


13
Fault Manager
Tivoli Enterprise Console
(I) 7.2


14
Fault Manager
Application Servers
(P) 7.3


15
Fault Manager
Locate Application Servers
(P) 7.3.1


16
Fault Manager
Start Application Servers
(P) 7.3.2


17
Fault Manager
Shutdown Application Servers
(P) 7.3.3


18
Fault Manager
Remove Red Applications
(P) 7.3.4


19
Fault Manager
Exit Application Servers
(P) 7.3.5


Detailed procedures for tasks performed by the Fault Manger are provided in the sections that follow.  

If you are already familiar with the procedures, you may prefer to use the quick-step tables.  If you are new to the system, or have not performed this task recently, you should use the detailed procedures presented in Sections 7.1.1 through 7.1.5 

For each procedure outlined in this section, there is a corresponding QUICK STEP procedures  immediately following the procedure in this chapter.  The QUICK STEP procedures are designed for persons who are experienced network administrators with prior monitoring/network administration experience.

7.1.1
Starting NNM (Network Node Manager)

HP OpenView Network Node Manager is a set of applications that are integrated with HP OpenView Windows (OVW).  To Start NNM, HP Openview Windows must be activated first.  Once activated, OVW will automatically start NNM.  HP Openview windows will also automatically start the applications that are installed and registered.

Prerequisites for this Task

The network management processes that work with OVW and NNM must be running.  The network management processes consist of the following HP OpenView background processes: ovwdb, trapd, ovtopmd, ovactiond, snmpCollect, and netmon.  You can check to see if these processes are running with /usr/ov/bin/ovstatus command.

1.
Check for required processes

     The Deputy Agent must be running on the MSS Server.

     -- Login to the MSS Server.

     -- Determine if the Deputy Agent is running (/bin/ps -ef | grep EcMsAgDeputy)

-- If not, start it by doing the following:

-- Run /usr/ecs/SHARED/CUSTOM/utilities/EcMsAgStartDeputy SHARED. The script determines if the Deputy Agent is already running (only one copy of Deputy Agent should be running at a time).   

2.  The Subagent must be running on the host(s) where you want to manage

      applications.  If not, start it by doing the followings:

-- Run /usr/ecs/SHARED/CUSTOM/utilities/EcMsAgStartSubagent SHARED.

(only one copy of Deputy Agent should be running at a time).   

3.
EcMsCmEcsd process must be running.  

-- Determine if the "EcMsCmEcsd" process is running 

-- (/bin/ps -ef | grep EcMsCmEcsd). 

     
-- If not, start it by doing the following:

    
 
-- Run /usr/ecs/SHARED/CUSTOM/utilities/EcMsCmStartEcsd

This procedure explains how to start the HP OpenView Windows graphical user interface.

1
Set and initiate the appropriate environment variables: 

· setenv DISPLAY hostname:0.0
· setenv ECS_HOME  /usr/ecs

· setenv SHLIB_PATH /opt/OV/lib

· source /opt/OV/bin/ov.envvars.csh
· source /etc/Tivoli/setup_env.csh

· If the map is opened as a "read-only" map ("read-only" or "read-write will be indicated in the lower left corner of the GUI), you will need to use the "File->Refresh Map" menu item to refresh the map whenever there are changes other than symbol color changes.
2
Type $OV_BIN/ovstart at the command prompt and press enter.

· If the network management processes are not running, you can start them by executing the $OV_BIN/ovstart command.

3
Type ovstatus at the command prompt and press enter.

· This command will check the status of the processes.


Start the HP OpenView Windows NNM Graphical Interface

4      cd /data1/OPS/COTS/OV/bin  and press enter

-- Type $OV_BIN/ovw  -map mapname & at the command prompt and press enter.  This displays a map with two icons (IP Network and Services).  

-- If HPOV is started without specifying a map, then the view is an expanded version of your current node.  

 -- If the map is opened as a "read-only" map ("read-only" or "read-write will be indicated in the lower left corner of the GUI), you will need to use the "File --(Refresh Map" menu item to refresh the map whenever there are changes other than symbol color changes.

-- Double click on either the Internet or Services symbol to expand either symbol.  

To exit NNM and all other integrated applications, you must exit OVW.  You can exit OVW in one of the following ways:

6
Select File:  Exit from the menu bar of any submap window or go to step number 7;

7
Click on the Close button on all open submap windows until a black submap window is displayed.  When the black submap window is displayed, click on the Close button.

· The open map is saved, and all the submap windows and dialog boxes of the map are closed.  OVW, all NNM applications, and all other integrated applications exit.

IMPORTANT:  Do not use the Quick-Step version of a procedure unless you are already very familiar with the procedure.  To start NNM, execute the steps provided in the table.  

Table 7.1-2.  Starting/Monitoring NNM - Quick-Step Procedures

Step
What to Enter or Select
Action to Take

1
Login to appropriate machine
press Return

2
setenv DISPLAY  IPNumber:0.0  -- or –

setenv DISPLAY hostname:0.0
press Return


cd /data1/OPS/COTS/OV/bin
press Return

3
$OV_BIN/ovstart (HPOV not running) 
press Return

4
ovw& 
press Return

5
Select Monitor – or – Diagnose
press Return

5
Select device Configuration –or—Network Connectivity
press Return

6
Select System information –or – Demand Poll
press Return

7
$OV_BIN/ovw -map mapname&
press Return

7.1.1.1 Configure Monitoring Settings

This section explains how to configure the appropriate elements to be managed and monitored by HP Openview. To ensure that the appropriate elements are being included as an elements to be monitored and managed by HPOV:  

1.
Bring up the IP Internet submap by double clicking on the IP Internet icon.

2.
Ensure that all icons representing managed objects (managed hosts and        
network devices, as listed in the site hardware baseline mapping) are being 
managed. An unmanaged icon will normally be wheat-colored. A managed icon 
will usually be blue, green, yellow, or red. 


-- A view of the color scheme currently in use by HPOV can be obtained by  
selecting:  



-- Help->Display Legend.

3.
To manage objects that are currently unmanaged by HPOV, 


-- select the object by left-clicking on the object



--  then select "Map--> Manage Objects" menu option. 



The color of the icon representing this object should change to indicate 


that the object is now being managed by HPOV. Once the object becomes 


managed, additional icons may appear on The map as HPOV discovers 


other devices that are connected to that object.

4.
Repeat step 3 (above) until all unmanaged objects at the site are managed.  

5.
Note: 
HPOV may discover some icons to be part of a subnet, and  group them together under a subnet icon. In this case, the object icons may be found by "drilling down" to the next level (double- clicking on the subnet icon). If an object that should be managed by  HPOV cannot be found, look for it by using the 
-- Locate->Selected  Objects List... menu item. 




--  This will bring up a "Locate by Selection  Name" window. 


The object (if it has been discovered by HPOV) can be found by typing all or part of the object name into the box labeled "Regular Expression (or substring):" on this window. When the name (or a part thereof) is entered and the "Apply" button is selected, HPOV will search for all instances of this object and will list them in the "Located and Highlighted:" box. If an object still cannot be found, it has not been discovered by HPOV. The most likely reasons  for this would be if it is connected to the network via another device that has also not been discovered or it has been down since HPOV started its discovery process.

6.
Ensure that all icons not representing managed objects are unmanaged.


Note:  HPOV can manage additional network devices; however, the process of managing the device will cause additional network traffic that may not be desired, especially if the device is not owned by ECS.

7.
To unmanage an object that is currently being managed by HPOV, select the icon by left-clicking on it and then select the "Map-> Unmanage Objects" menu option. The color of the icon should change to wheat fairly quickly to indicate its unmanaged state.

7.1.2
Verify That an Object Is Not Functioning

This section explains how to verify that an object is not functioning and assumes that HP Openview is running.  If not, then see section 7.1.1  To verify that an object is not functioning, any of the following procedures can be executed.

1
Select the Configuration pull down menu

2
Select System Information
- OR -

1
Select the Fault pull down menu

2
Select Network Connectivity: Poll Node
- OR -

1
Select the Fault pull down menu

2
Select Ping 

If these operations do not produce any responses or they time out, then the node is probably down or otherwise unreachable over the network.  See Section 7.1.5 Checking for Event Notifications to verify event status of the node. If a Fault has occurred see Section 8 on Problem Management and Section 21 COTS Hardware Maintenance.

IMPORTANT:  Do not use the quick step version of a procedure unless you are already very familiar with the procedure.

To verify that an object is not working, execute the steps provided in the table.  

Table 7.1-3.  Verify - Quick-Step Procedures

Step
What to Enter or Select
Action to Take

1
Configuration
Use the pull down menu

2
System Information
Pull down menu

7.1.3 
Looking at Maps for Color Alerts

Looking at maps for color alerts, HP OpenView uses colored symbols to indicate the health and operational status of the various objects within the network.  Operational status refers to the actual operation of the node on the sub-map.  Operational status is changed by Network Node Manager(NNM) automatically when a change in the operational condition of the node is detected.

Table 7.1-4.  Operational Status Colors

Symbol color
status

Blue
UNKNOWN. A device or a network that has been discovered by NNM. This can happen when a non-IP addressable device has been added to the map manually and NNM has not yet discovered it. The status is set to unknown. It cannot be determined.

Green
NORMAL. The device or network is up and functioning normally. The object is in its normal operational state.

Cyan
WARNING.  There is a potential fault or problem

Yellow
MINOR or MARGINAL.  There is something wrong with this object, but the device is still responding to NNM.

Orange
MAJOR. The object is in a state of having a major fault or problem.

Red
CRITICAL or DOWN.  The device is not responding to NNM.

Looking at maps for color alerts

To check your network for color alerts, you must first have the map for the network open.  To open a map, use the following procedure:

1. With HP OpenView NNM running, follow menu path Map->Maps->Open/List 

· The Available Maps dialog box is displayed. 

2. Select the name of the map you want to open and click on “Open Map”.

· A confirmation box is displayed

3.  Click “OK”. 

· Any open map and its sub-map windows and dialogs close.

· The Home Sub-map (Root) of the selected map is displayed.

If you do not know the compound status scheme of the open map, follow the menu path File->Describe/Modify Map to obtain the Map Description dialog box and display/set the compound status scheme for default. Suppose there is a fault in an interface card in one of the workstations on your network. Use the following procedure to trace it using color alerts.

Looking at Maps for Color Alerts 

1. Double click on the yellow IP Internet symbol

· Note:  The symbol will be yellow because the critical failure of the card in the workstation is propagated up to the level of the IP Internet symbol as a minor problem at that level.

· The Internet sub-map opens and displays the IP network(s). One network symbol is yellow. This indicates a marginal problem with the network.

2.  Double click on the yellow IP network symbols.

· A network sub-map opens and displays the segment(s) attached to the gateway(s). The segment symbol is yellow. This indicates a problem somewhere on the segment.

3.  Double click on the yellow segment symbol.
· A segment sub-map opens and displays the nodes attached to that segment. Of all the nodes in the segment, the workstation node is red. The problem is isolated to that workstation.

4.  Double click on the red workstation symbol.
· A Node sub-map opens and displays its interface symbol. It is red.

· You have isolated the fault to a single card of a single node on your network.

IMPORTANT:  Do not use the quick step version of a procedure unless you are already very familiar with the procedure.

To look at Maps for Color Alerts, execute the steps provided in the table.  

Table 7.1-5.  Color Alerts- Quick-Step Procedures

Step
What to Enter or Select
Action to Take

1
Internet Symbol
Double click

2
IP Network
Double click

3
Yellow segment symbol
Double click

4
Red workstation symbol
Double click

7.1.4
Looking at Maps for New Nodes

This section assumes that HP Openview is running.  If not, then see section 7.1.1  IP Map will automatically discover the IP-addressable nodes for the open map.  The purpose of this section is to identify new objects that have been discovered and added to the open map.  Because discovery is automated, additional symbols of objects on the network map will be seen.  IP Map must be enabled for the map.  This is the default.  IP Map places new symbols directly on the submap if autolayout is enabled.  IP Map places new symbols in the New Object Holding Area if autolayout is disabled for the submap.

1
To check the default Segment submap for any new nodes that may have been discovered, open the default Segment submap from the segment symbol in the Network submap.  

· View the submap for any new symbols.

2
To easily see new symbols in the submap, disable autolayout for the submap.  When autolayout is disabled, a New Object Holding Area appears at the bottom of the submap.  

· All newly added symbols are placed in the New Object Holding Area.

7.1.5
Creating Special Submaps for Monitoring Status

This section assumes that HP Openview is running on the desktop.  If not, then see section 7.1.1  Submaps can be created that are logically organized instead of physically organized.  This will help to create logical submaps for specialized monitoring.

IMPORTANT:  See section 4-5 of the HP Openview Network Node Manager User’s Guide to use this feature.

7.1.6
Checking for Event Notifications

This section assumes that HP Openview is running on the desktop.  If not, then see Section 7.1.1  Anytime a change occurs on the network an event is generated.  Through the Network Node Manager’s internal processes, the event is sent to a predefined category in the Events Browser window.  The Events Categories window provides a notification of when new events occur.  This window has a button corresponding to each of the event categories.  When the button that corresponds to a specific event category is clicked, a window listing the events for that specific category appears.  These windows are Event Browser windows.  When a button in the Event Categories window changes color, it is an indication that an event occurred on the network which relates to that category.  The color of the button indicates the highest severity event in the category.  The default categories included in the Event Categories window are:


Error Events.
   
This indicates inconsistent or unexpected behavior.


Threshold Events.    
This indicates that a threshold was exceeded.

Status Events.    
This indicates an object or interface status changed to up or

down, or an object or interface started or stopped responding to ICMP echo requests.


Configuration Events.    
This indicates a node’s configuration changed.


Application Alert Events. 
This indicates an HP OpenView Window 

application generated an alarm or alert.


All Events.   

This list all the above events and other events in one dialog 

box.

In the following example the Threshold Events button is red, which indicates that a critical threshold was exceeded somewhere on the network.

1
Click on the Threshold Events button in the Event Categories window.  The Threshold Events Browser dialog box appears with a chronological listing of the threshold events that have occurred, with the most recent events at the bottom of the list. 

•
Each event listed includes the severity, time the event occurred, node on which the event occurred, and a brief event message.

2
To view the node that generated the event shown in this example, select the event from the list and click on Action Highlight Source on Map.

· A map will appear with the busynode node highlighted.  At this point, select the highlighted node by clicking on it, and invoke appropriate operations from the menu bar to further diagnose and correct the situation which caused the threshold to be exceeded.

3
To delete the event, select the event and click on  Action Delete Selected Event.

· This will delete only the selected event.

· For more information about event notification, click on the help button in the dialog box for the event being viewed or select View SNMP Events from the Help: Index Task
IMPORTANT:  Do not use the quick step version of a procedure unless you are already very familiar with the procedure.

To check for Event Notifications, execute the steps provided in the table.  

Table 7.1-6.  Event Notifications - Quick-Step Procedures

Step
What to Enter or Select
Action to Take

1
Threshold Events
press Return

2
Action
press Return

3
Highlight source on Map
press Return

7.1.7
Rediscovering the Network

This section assumes that HP Openview is running on the desktop.  If not, then see section 7.1.1

Occasionally you may edit your maps beyond recognition and want to start from scratch.

1
Exit all Openview sessions (if running) cd /usr/OV/bin and then enter ovstop at the command line 

· This will stop all HP OpenView processes

2
Remove the Openview database (do a backup first)

· cd $OV_DB/openview
· rm -rf $OV_DB/openview/*
3
Remove all of the current events.

· rm $OV_LOG/xnmevents.*
· rm $OV_LOG/trapd.log*

· rm $OV_LOG/netmon.trace*
4
Clear the SNMP cache.

· cd /usr/OV/bin

· xnmsnmpconf -clearCache
5
Re register OVW fields.

· ovstart ovwdb
· ovw -fields

6
Restart NNM.

· ovstart
· ovw &

IMPORTANT:  Do not use the quick step version of a procedure unless you are already very familiar with the procedure.

Table 7.1-7.  Rediscovery - Quick-Step Procedures

Step
What to Enter or Select
Action to Take

1
Stop all OVW sessions
select exit from pull down menu

2
ovstop
press enter

3
cd $OV_BIN/openview
press enter

4
rm -rf $OV_DB/openview/*
press enter

5
rm $OV_LOG/xnmevents.*
press enter

6
rm $OV_LOG/trapd.log*
press enter

7
rm $OV_LOG/netmon.trace*
press enter

8
xnmsnmpconf -clearCache
press enter

9
ovstart ovwdb
press enter

10
ovw -fields
press enter

11
ovstart
press enter

12
ovw &
press enter

7.1.8
Starting and Shutting Down Servers from HP OpenView
Starting and Shutting Down Servers from HP OpenView

One of the key features of HP OpenView is its capability to start and shutdown system servers using the graphical user interface.  This can be accomplished either for all servers in a specific mode or individually by subsystem.  Using this procedure will save significant effort over command-line initiation of servers.
1

Start the HP OpenView application.
2
After the About OVW box is displayed, the OVW Root window will appear.  From the menu bar click on the Map; Maps; Open/List selections to bring up the Available Maps selection window.

3
Select the desired map to bring up the Root map that displays the Services and IP Internet icons.  Double click on the Services icon to display the Service submap.

4
From the Service submap select either the Mode icon to bring up the Mode submap to start or shutdown all servers for a given mode (TS1, TS2, OPS, etc.), or select a specific subsystem icon to start or shutdown servers for a specific subsystem. 

5
Right-click and hold on the desired Mode icon to display the pop-up menu.  Continue to hold and scroll down to either the Start executable or Shutdown executable option.  Release the right mouse button and the servers for the selected mode will start or shutdown.

6
To start or shutdown specific servers in a subsystem (CLS, MSS, IDG, etc.), double-click on the desired subsystem icon in the Service submap.  
7
From the expanded submap right-click and hold on the desired server application to display the pop-up menu, scroll down to the Start executable or Stop executable option, release the button and the server will start or shutdown.
In order to assist the DAACs with possible recovery issues, the following guides are provided:

1
A core dump of a SubAgent will not cause any other servers on a monitored host to core dump.  It can, however, result in green icons displayed for servers that died while the SubAgent was down or blue icons for servers for which only partial events were received/sent.  The following steps can help recover the state of the OpenView maps for the ECS monitored servers.

2
These incorrect objects can be removed manually by selecting Edit->Delete->From All Submaps after highlighting the erroneous object.  It is important to "drill-down" to the lowest level and delete the objects from the lowest level and then from higher levels.  This prevents "orphaned" objects from cluttering the OpenView object database ie) program level objects without application level parent objects.  If you delete the application level icon first, only the application object is removed.  The program and process level object remains in the database and can cause erroneous results in the future.  

3
To recycle the custom server monitoring maps in OpenView, select the following from the OpenView menu bar: Misc->ECS Application->Remove all ECS objects.  You may need to select this option twice to delete all objects as OpenView occasionally misses objects when deleting a large number of objects.  After the deletion, you will need to wait for a rediscovery cycle to complete before all currently running servers and all installed applications are displayed in OpenView.  By default, the rediscovery cycle occurs every 20 minutes and is set the SubAgent configuration file as the option MsAg_DiscoverInterval_sec.  The object database can become corrupt even when only hardware is being monitored by OpenView without the additional events generated by the ECS custom monitoring.  The next step gives instructions on completely cleaning the object database.  HP refers to this as a "forced rediscovery".

HP gives guidelines for cleaning the HP OpenView object database, which is the only way to recover the state of the object database if it becomes corrupt.  The steps are as follows:

· kill -15 <EcMsAgDeputy pid>

· kill -15 <EcMsCmEcsd pid>

· Exit all ovw sessions

· Stop all NNM processes using the command 'ovstop' as root

· source /opt/OV/bin/ov.envvars.csh (or .sh as dictated by your current shell)

· cd $OV_DB/openview

· rm -rf defmap mapdb ovwdb topo

· cd $OV_LOG

· rm xnmevents.* trapd.*

· xnmsnmpconf -clearCache

· ovstart ovwdb

· ovw -fields

· ovstart

· ovw (run as root to recreate the directory structure)
· restart EcMsCmEcsd
· restart EcMsAgDeputy
You will need to wait for a rediscovery cycle to occur after clearing the database for all running servers and installed applications to be displayed again.
7.2
Tivoli Enterprise Console

The Tivoli Enterprise Console (TEC) provides centralized processing and management of distributed events, the ability to allow shared or partitioned administrator responsibilities based on enterprise-defined areas of responsibility, and a flexible interface to view and respond to events based on the events severity, source, location, or other characteristics.  The following tables document the Tivoli event configuration.

Table 7.2-1.  Disk Event Configuration

Resource
Response Level
Trigger When
Threshold
Response

Inodes Free
Warning
Less than
200
Change icon.


Severe
Less than
150
Send Tivoli notice.

Change icon.


Critical
Less than
100
Send Tivoli notice.

Change icon.

Popup alarm.

Inodes Used
Warning
Greater than
X
Change icon.


Severe
Greater than
X
Send Tivoli notice.

Change icon.


Critical
Greater than
X
Send Tivoli notice.

Change icon.

Popup alarm.

% Inodes Used
Warning
Greater than
80
Change icon.


Severe
Greater than
90
Send Tivoli notice.

Change icon.


Critical
Greater than
95
Send Tivoli notice.

Change icon.

Popup alarm.

Space Free
Warning
Less than
200 MB
Change icon.


Severe
Less than
100 MB
Send Tivoli notice.

Change icon.


Critical
Less than
50 MB
Send Tivoli notice.

Change icon.

Popup alarm.

Space Used
Warning
Greater than
X
Change icon.


Severe
Greater than
X
Send Tivoli notice.

Change icon.


Critical
Greater than
X
Send Tivoli notice.

Change icon.

Popup alarm.

% Space Used
Warning
Greater than
80
Change icon.


Severe
Greater than
90
Send Tivoli notice.

Change icon.


Critical
Greater than
95
Send Tivoli notice.

Change icon.

Popup alarm.

Tivoli DB Free Space
Warning
Less than
20 MB
Change icon.


Severe
Less than
10 MB
Send Tivoli notice.

Change icon.


Critical
Less than
5 MB
Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-2 Security Event Configuration (1 of 2)

Resource
Response Level
Trigger When
Threshold
Response

Check File Permission:





/etc/passwd
Critical
Changes from
-rw-r--r--
Send Tivoli notice.

Change icon.

Popup alarm.

Compare Files:





Daemon Status:





amd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

biod
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

cron
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

inetd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

lockd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

lpd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

mountd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

nfsd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

portmap
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

snmpd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-2 Security Event Configuration (2 of 2)

Resource
Response Level
Trigger When
Threshold
Response

statd
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.

File Checksum:





/etc/passwd
Warning
Not equal to
value
Change icon.

File Size:





/var/adm/messages
Warning
Greater than
200 Kbytes
Change icon.

Occurrences in File:





/var/adm/messages
Warning
Greater than
value
Change icon.

Process Instances:





tivoli
Warning
Greater than
3
Change icon.

HP OpenView
Warning
Greater than
3
Change icon.

User Logins by User:





root
Warning
Greater than
1
Change icon.

Users Logged in
Warning
Greater than
20
Change icon.


Severe
Greater than
25
Send Tivoli notice.

Change icon.


Critical
Greater than
30
Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-3.  Network Event Configuration (1 of 3)

Resource
Response Level
Trigger When
Threshold
Response

Client RPC timeouts
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Server Status





Network Collisions
Warning
% increase of
5
Change icon.


Severe
% increase of
10
Send Tivoli notice.

Change icon.


Critical
% increase of
25
Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-3.  Network Event Configuration (2 of 3)

Resource
Response Level
Trigger When
Threshold
Response

Network Collisions/packets
Warning
% increase of
5
Change icon.


Severe
% increase of
10
Send Tivoli notice.

Change icon.


Critical
% increase of
25
Send Tivoli notice.

Change icon.

Popup alarm.

NFS bad calls
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Input packet errors
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Input packets
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Output packet errors
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Output packets
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.







Table 7.2-3.  Network Event Configuration (3 of 3)

Resource
Response Level
Trigger When
Threshold
Response

Remote oserv status
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.







RPC bad calls
Warning
% increase of
10
Change icon.


Severe
% increase of
25
Send Tivoli notice.

Change icon.


Critical
% increase of
50
Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-4.  System Event Configuration (1 of 2)

Resource
Response Level
Trigger When
Threshold
Response

Available swap space
Warning
Less than
20 MB
Change icon.


Severe
Less than
15 MB
Send Tivoli notice.

Change icon.


Critical
Less than
10 MB
Send Tivoli notice.

Change icon.

Popup alarm.

Host status:





cyclops
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.







Lingering terminated processes
Warning
Greater than
10
Change icon.


Severe
Greater than
20
Send Tivoli notice.

Change icon.


Critical
Greater than
30
Send Tivoli notice.

Change icon.

Popup alarm.







Load average
Warning
Greater than
10
Change icon.


Severe
Greater than
20
Send Tivoli notice.

Change icon.

Table 7.2-4.  System Event Configuration (2 of 2)

Resource
Response Level
Trigger When
Threshold
Response


Critical
Greater than
30
Send Tivoli notice.

Change icon.

Popup alarm.







Mail queue length
Warning
Greater than
20
Change icon.


Severe
Greater than
40
Send Tivoli notice.

Change icon.


Critical
Greater than
50
Send Tivoli notice.

Change icon.

Popup alarm.







Page-outs
Warning
% increase of
50
Change icon.


Severe
% increase of
80
Send Tivoli notice.

Change icon.


Critical
% increase of
90
Send Tivoli notice.

Change icon.

Popup alarm.

Table 7.2-5  Printer Event Configuration (1 of 2)

Resource
Response Level
Trigger When
Threshold
Response

Daemon status:





lpsched
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.







Jobs in print queue:





print_queue
Warning
Greater than
10
Change icon.







Status of print queue:





print_queue
Critical
Becomes unavailable

Send Tivoli notice.

Change icon.

Popup alarm.







Table 7.2-5  Printer Event Configuration (2 of 2)

Resource
Response Level
Trigger When
Threshold
Response

Total size queued:





print_queue
Warning
Greater than
10 M
Change icon.


Severe
Greater than
20 M
Send Tivoli notice.

Change icon.


Critical
Greater than
30 M
Send Tivoli notice.

Change icon.

Popup alarm.

X - system dependent parameters.

7.3 Application Servers

HP OpenView has the capability to monitor the status of each application server and its mode.   Through the use of this capability, both Tivoli and Remedy can be invoked from the option bar.  These procedures assume that HP OpenView is active and available for service, otherwise follow steps 1-7 of 7.1.1 to start the server. 

This procedure explains how to maneuver the HP OpenView Windows graphical user interface for application servers: . 

1
Type  /opt/OV/bin/ovw -map XXXX & press enter.

· This command will display the appropriate IP and application server map: 

· **XXXX is the name of a previously created map 

· This command will display  both the hardware map and the services map 

2
Double-click Services icon

· This command will display  the service map, which displays each application and mode as icons.  The colors of the icon indicate the state of the application server – (Select Help – select Legend - will display of the color legend) 

· This screen can be closed by double-clicking the 1st icon on the icon bar located above the display and below list of  choices.  

· This command will display the status of each application server

3
Double-click mode icon 

· This command will display the mode map which has an icon for each mode (Shared, TS1, TS2, and OPS) 

· This command will display the status of the modes.

Double-click on one of the modes icon

· This command will display the executable module icon for the specific mode selected. 

· This command will display the status of the executable modules.  


Double-click mode icon 

· This command will display the mode map which has an icon for each mode (Shared, TS1, TS2, and OPS) 

· This command will display the status of the modes.

--  OR --

4 
Double-click on one of the application server icons

· This command will display the executable application servers map.  Each icon represents an executable module.  

· This command will display the status of the executable modules.  

Double-click on one of the application servers icon

· This command will display the executable module icon for the specific mode selected. 

· This command will display the status of the executable modules.  


Double-click application server icon 

· This command will display the mode map which has an icon for each mode (Shared, TS1, TS2, and OPS) 

· This command will display the status of the modes.

7.3.1 Locate Application/Program icons

 1.
From the HPOV menu bar, select: Locate->Objects->By Selection Name (or

        CTRL+N)

2.
Type Application/Program ID desired (i.e., 7000004).

    
 -- Hit "Apply" button and then locate the desired object. The object name 

        has a naming convention of "applID_hostname_instID_mode" for an application object or "progID_applID_hostname_instID_mode" for a program object. You should select the one with an instID of -1, which indicates that the object represents the installed Application/Program.

3.
Choose "Open" , then "Select" to highlight the desired icon.

4.
Check the label of the installed application/program icon (wheat in 

        color) to verify whether it is for the desired mode.

7.3.2
 Start an Application/Program

1.
 Right-click on installed application/program icon (wheat in color).

2.
 Select "Start executable".

3.
A start executable request will be sent to the Subagent on the selected 

managed host.

4.
A new green application/program icon will be populated onto the map if 

        
the application/program has been started correctly.

5.
Verify that the desired server programs are started by double-clicking

        
the application icon to go to the program level submap.

7.3.3
Shutdown an Application

1.
Right-click on running application/program icon (green in color).

2.
Select "Shutdown executable".

3.
A shut down executable request will be sent to the Subagent on the 

selected managed host.

4.
The green application icon will be removed from the map if the 

        
application has been shut down properly.

7.3.4. Remove Red Application/Program icons (dead executable symbols) from the map

1.
Make sure you really want to remove all red Application/Program  icons

        
from the map.

2.
Select the "Misc. -> ECS Application -> Remove Died Executable

Symbols" menu item from the HPOV menu bar.

     
-- The word "Sync" will appear at the lower left corner of the OV GUI.

        
-- After the "Sync" label disappears, all red ECS Application/Program

        icons will be removed from the map.

7.3.5 Exit HP OpenView and stop background processes

1.
Select Map->Exit (CTRL +E).

     
-- Stop any background processes you have started by entering ctrl-c or a "kill" command.
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